easyHDR PRO 1.70
documentation
# Table of contents

1. Quick start ........................................................................................................................................ 4

2. HDR radiance map generation ........................................................................................................... 6
   2.1. Taking the photographs ............................................................................................................... 6
   2.2. Image sequence loading .............................................................................................................. 7
   2.3. Chromatic aberration correction ............................................................................................... 7
   2.4. Alignment .................................................................................................................................. 9
   2.5. HDR generation ......................................................................................................................... 12
       2.5.1. True HDR ........................................................................................................................... 13
       2.5.2. Smart Merge ....................................................................................................................... 14
       2.5.3. Image Stacking .................................................................................................................. 15

3. Tone mapping .................................................................................................................................... 16
   3.1. Global vs. local operator .......................................................................................................... 17
   3.2. Global Operator: Compression, Gamma & Saturation ................................................................. 17
   3.3. Global Operator: Curve adjust .................................................................................................. 18
   3.4. Local Operator: Mask .............................................................................................................. 19
   3.5. Local Operator: Local Contrast .............................................................................................. 21
   3.6. Black & white clip .................................................................................................................... 22

4. Post processing ................................................................................................................................... 24
   4.1. Gaussian blur (smoothing) ......................................................................................................... 24
   4.2. Unsharp mask (sharpening) ...................................................................................................... 24
   4.3. Median filter (noise reduction) ................................................................................................ 25
   4.4. Bilateral filter (noise reduction) ............................................................................................... 25
   4.5. Neutral point (white balance) .................................................................................................. 26
   4.6. Sample/target balance ............................................................................................................. 27
   4.7. Color tone .................................................................................................................................. 28
   4.8. Image transformations ............................................................................................................... 29

5. Batch processing ............................................................................................................................. 29
   5.1. Task list creation ......................................................................................................................... 30
5.2. HDR Generation & Tone Mapping settings ..............................................................31
5.3. „Save as” options and processing ........................................................................32
5.4. Generating HDR image files only ........................................................................32

6. Camera RAW image import ......................................................................................33

7. Projects & Settings ..................................................................................................35

8. Saving the result .......................................................................................................35

9. Program options .......................................................................................................37
1. Quick start

a) Take a set of photos of the same high dynamic range scene at different exposure times, ISO values or f-stops. In order to achieve best results the Exposure Value difference between the photos should be 1 to 2EV. EasyHDR will load not only JPEG photos, but also RAWs, TIFFs and FITs.

b) Click File->Open and select all of the photos from the sequence that you want to blend into HDR. You can also load a single image and do only LDR enhancement. There is always a possibility to open additional photos or to remove those loaded by mistake.

c) Click "Generate HDR" button if you want to create the High Dynamic Range radiance map from the loaded photo sequence, or "LDR enhancement" if you want to process a single image. If you have chosen to blend the photos into a HDR image, the HDR generation window will appear. Check if the calculated EV values are correct (they are calculated upon EXIF data or estimated if EXIF headers are not available) and choose appropriate options (anti-blooming and response curve type).

d) If the loaded photos are misaligned in respect to each other you may choose one of two possible options in order to align them before generating the HDR radiance map. The automatic alignment feature is capable of compensating for shift as well as rotational misalignment. However, by choosing the manual alignment you have much more control over the entire process. The manual alignment tool is capable of compensating for shift, scale, rotation and perspective. Just select the main (base) photo and place the pin pairs (each pair is marked with a different color), so they point exactly the same details visible on the base picture as well as on the photo to be aligned to it.

e) In many cases however, automatic alignment will be sufficient. Just choose the base image to which the function shall align the rest of the photos and click "Apply". When the alignment is done you may save the transformed photos for future use. You can do it any time - before or after generating the HDR radiance map.

f) When the alignment is done you can finally generate the HDR radiance map. You can also choose to save the generated HDR image to a file in Radiance RGBE (.hdr) format. Instead of generating a true HDR radiance map, there is a possibility to merge the photo sequence using a pseudo-HDR algorithm (called Smart Merge) or to generate an image stack (average). In case of processing very big photos it may sometimes be useful to enable HDR image size reduction.

g) When the HDR is generated the photo is automatically tone mapped and resized (tone mapping preview size reduction) so the previewing process is much faster. Now you can manually tune the settings using the sliders, histogram clipping option and the curve adjust tool.

h) While using the histogram clipping, use the overexposed and underexposed areas marking option. The clipped areas will be marked with blinking red or blue respectively.

i) Having chosen the best settings you may process the whole image to get the final result by clicking the "Process all" button. The size reduction will be turned off automatically (set to 1x). When the size reduction is disabled it is possible to preview a preselected image area at full resolution, so you can try various tone mapping settings quickly, while monitoring the result photo in the highest detail. Note that when the "Process all" button is clicked the HDR image size reduction (defined in the HDR generation window) is not disabled. In such a case, in order to process the photo at full resolution the HDR radiance map must be recalculated.

j) Before saving you may wish to process the photo using available filters - blur, sharpening, noise removal, white balance, sample/target balance or color tone adjustment. The processing is done on floating point data so there are no quality losses due to quantization or lossy compression.
k) Now you can save the result (File->Save). When saving as JPEG choose the input photo from which the EXIF data shall be copied (if the EXIF is available). Note that easyHDR adds an additional field to the EXIF that contains a list of input images used to achieve the final photo. For best quality choose to save as 48-bit TIFF (16-bit per channel).
2. HDR radiance map generation

2.1. Taking the photographs

The dynamic range (or the luminosity range) is the ratio between the brightest and the darkest part of the photographed scene. The human vision can accommodate (in long term) the dynamic range of $10^{14}:1$ (from starlight to bright objects in full sunlight). The light accommodation is achieved mostly by chemical means, the iris is simply not as flexible. The human eye covers the dynamic range of about 100 000 : 1 at one time, just the top dynamic range of most real-world scenes. In comparison the dynamic range of typical digital cameras is about 1000-4000 : 1 and in case of computer displays it is even much worse. However, having the ability to cover a very wide dynamic range, the human brain is not able to distinguish small changes in brightness and also human perception is logarithmic rather than linear. Of course the digital camera and computer display design take advantage of that fact.

The camera chip (CCD or CMOS) responsivity is more or less linear. A 12-bit RAW image is converted to an 8-bit per channel photo using a compression curve stored in the camera in a Look Up Table (LUT). So the whole dynamic range that the camera can cover is compressed (fitted) into 8-bit (0..255) values.

EasyHDR allows you to create a photo that covers a much wider dynamic range than a single image taken with a typical digital camera. First of all you have to acquire enough luminosity information from the photographed scene. You can do that by taking several photographs at different...
exposure times so the whole dynamic range is covered. The brightest details have to be clearly visible in
the shortest exposure and the darkest should be visible in the longest exposure image. It is
recommended to set exposure times such that the Exposure Value (EV) step between the images is
about 1 or 2 EV. In most cases 3 images will be sufficient. In order to take the image sequence
automatically with your digital camera, you can use the Auto Exposure Bracketing (AEB) option.

For best results, the images shouldn't be too misaligned and therefore should be taken with a
camera on a tripod. However there is an automatic as well as manual alignment feature in easyHDR.
The manual alignment tool can compensate for shift, scale, rotation and perspective misalignments
between the photos.

2.2. Image sequence loading

In order to load the image sequence just click File->Load and multi-select all of the photos from
the sequence to be opened. Of course you can load them also one by one, or remove any of them if
loaded by mistake. If you load only one photo you'll be able to enhance it with the tone mapping
operators that are normally used on HDR data. This feature is called "LDR enhancement". EasyHDR
will also load photos dragged and dropped on the main program window.

EasyHDR loads JPEG photos as well as 24 and 48-bit TIFFs. It also features a built-in RAW
converter (DCRAW) that is capable of importing almost all of the RAW photo formats by all digital
camera vendors. It is also possible to load FITS file format, that is most commonly used in
astrophotography. EasyHDR also supports Radiance RGBE (*.hdr) and 96-bit, floating point TIFF.

2.3. Chromatic aberration correction

Chromatic aberration is one of the optical defects of lenses. It occurs when the lens does not
focus all light wavelengths in one point, because of different refractive index for different wavelengths.
In the photo it appears as “fringes” of color around dark-bright boundaries. This effect gets stronger
towards the borders of the photo and typically is the lowest (or does not exist at all) in the center of the
image. Chromatic aberration effect can be very low in the most expensive achromatic lenses, however
there is a way to reduce this effect even if the photo was taken with typical amateur equipment.
In easyHDR there is a manual Chromatic Aberration Correction tool that allows you to repair your photographs and to increase their quality. It must be used right after the photos have been loaded, before they are aligned or used for generating a HDR image.

After starting the tool select one of the photos from the loaded sequence that will be used for previewing. You can select the photo area by moving the mouse cursor over the preview window with the left button held down. By clicking the right mouse button you can mark the Central Point – in most cases it should be in the exact center of the photo and to that position it is set by default.

Color images can be split into 3 channels – Red, Green and Blue. Because of the chromatic aberration all of the channels are not exactly in the same focus. It causes the red channel to get a bit too big and the blue channel becomes a bit too small as compared to the green one. The Chromatic Aberration Correction tool allows to slightly resize the red and the blue channels so that they match together ("Scale (red)" and "Scale (blue)" sliders). There is also an additional parameter available: "Distortion correction". It can be used if it appears impossible to achieve satisfying results with the above mentioned scale modifiers. It makes the scale factors to be uneven in the entire image. The scale varies (rises or falls) along with distance from the central point. This may be mostly useful in case of lenses with short focal-lengths, where the image distortion effect is the strongest.

When you change the parameters the preview is calculated automatically. You can have a look at the original input by holding down the "Show input image" button, or by holding down left mouse button on the preview image.
After selecting the best parameters you can check whether they also work for other photos from the same sequence – they should because the photos were taken with the same lens. It should be noted however that the aperture stop settings also have their influence here.

Finally you can apply the correction to all of the loaded photos, or just to the one that is selected. It is also possible to save the settings for future use – or when you plan to use chromatic aberration correction in the batch mode.

2.4. Alignment

In order to get the best sharp and fine detailed results, the photo sequence used to generate the HDR radiance map should be taken with a camera on a tripod. Of course it is not always possible. Even the fastest cameras, with exposure bracketing option enabled, still need quite much time to take the full sequence. The slightest move of a hand during that process can cause the acquired photos to be misaligned in respect to each other.
Manual alignment

EasyHDR has a built-in manual alignment tool that can be used to align the photos if it's needed. The tool uses planar stretching method that is controlled (by the user) by manual placement of 4 pins.

![Tone mapped HDR blended from misaligned photos.](image1)

![After manual alignment.](image2)

Below is the procedure that leads to generation of a HDR radiance map from a misaligned sequence of photographs:

- Load a sequence of photos into the program and click "Manual alignment" button in the main or "HDR generation" window.
- Choose the base photo to which the remaining images shall be aligned. The base photo will appear in the top, left scroll box.
- Open one of the remaining photographs in the top, right scroll box. This is the photo that will be transformed by the program in order to be well aligned to the base image.

![Manual alignment window. The base photo as well as the photo to be aligned are opened.](image3)

![Preview is calculated for the default pin positions (no transformation).](image4)

- Set the pins, on the two loaded images, so they point at exactly the same object details of the photographed scene. It is a good practice to initially place the pins close to the chosen scene.
features while the zoom is set to a small value and later fine tune the placement at zoom of around 100-200%. The keyboard arrows can be used to position the pins as well. Just click on the pin and while still holding the mouse button use the arrows. The pin position change is applied when the mouse button is released. When the right Shift key is held the arrow keys move the selected pin by 10 pixels.

- Repeat the operation described in the previous two points on every photo, that shall be aligned to the base. Note that it is possible to set different pin positions for the base photo and for each image pair. Because of this you do not have to choose the photo details (that are pointed to by the pins), which are not over- or underexposed in all of the exposures.

- Click the "Apply" button. The photos will be aligned and in the next step you will finally be able to generate the HDR radiance map.

The blue pin points exactly the same scene feature on both loaded images. The preview is calculated and shown in the bottom, left scroll box.

All pins are in their positions. The preview style is set to "Difference".

The pins should be well spread over the photograph. The best case is when they are located near the corners. Placing them too close to each other or setting 3 or 4 of them in one line will result in big alignment errors and therefore should be avoided. A score value (0 to 100) is calculated by the program to help you set the pins correctly. Values below 50 are considered as too bad to give satisfying results.

If perspective correction is not needed you may turn that feature off and use the manual alignment tool to compensate for shift, scale and rotation misalignment. In such a case only 3 pins are used. It is also possible to compensate for the shift only (1 pin).

Automatic alignment

There is also an automatic alignment tool available. It is capable of compensating for shift only, or for shift and rotational misalignments. However, in many cases it will be sufficient to use it instead of the manual option. The function aligns the photos to the base photo chosen by the user. In most cases choosing the middle exposed photo will give best results.
Saving the aligned photos

When the alignment is done it is possible to save the transformed photos for future use. The files are saved to a chosen directory with a prefix added to the file names.

Undoing the alignment

When the results of the alignment are not as good as anticipated (in case of automatic option) and you'd like to try again manually, it is possible to undo the already done transformations without loosing image quality. In order to do so just click "Undo alignment" button.

2.5. HDR generation

After loading the photo sequence click on the "Generate HDR" button. A HDR generation window will appear. It offers three algorithms that generate either a HDR radiance map (True HDR) or a pseudo-HDR image (Smart Merge and Image Stacking).
Options common for all algorithms:

- **Alignment**: If the photos in the sequence are misaligned use automatic or manual alignment. The automatic solution will compensate for shift and rotational misalignments. The manual alignment tool is additionally capable of compensating scale and perspective. For more information see the paragraph 2.4.

- **Photo selection**: There is a possibility to uncheck the photos that you don't want to be used by the algorithms (may be useful for tests).

- **HDR image size reduction**: If the input photos are very big and you want to quickly test different HDR generation settings or you're just interested in generating a smaller version of the photo, you can take advantage of the HDR image size reduction option. Note that this feature is not the same as the "size reduction" available in the tone mapping panel (tab 2).

### 2.5.1. True HDR

The True HDR method generates a radiance map that closely represents the real light radiance that was focused by the lens on the image sensor when the scene was photographed. This method requires proper Exposure Values set for the particular photos in the sequence.

When the HDR generation window is opened the program reads the appropriate exposure time, ISO and f-number values from JPEG, TIFF or RAW EXIF headers and utilizes them to calculate the true EV (Exposure Value). If there is no EXIF data embedded in the files, the photos are sorted from the
darkest to the brightest and the Exposure Values are set up to meet the spacing requirement. You can also edit each of the EV independently. Note that these values are critical in HDR calculation process, especially when you want to receive a realistic result. Learn more about the Exposure Value.

There are a couple of options available for this algorithm:

- **Response curve**: Select "Standard (JPEG)" if you have loaded JPEGs, BMPs or TIFFs that were internally processed in your camera. Select "Standard (RAW)" if you have loaded RAWs, 48-bit TIFFs that were converted from RAW format, or FITs. This option is set automatically by the program, but is allowed to be changed for user experiments.

- **Anti blooming**: Choose "Normal" if there are big overexposed patches on some of the images in the sequence. This will reduce blooming artifacts, significantly reduce the noise and also cause the HDR to look more dramatic. However if only some small parts of the photos are overexposed, the "Normal" setting can flatten the result and therefore should be avoided. "None" should be used instead. The "Selective" method does not flatten the result so much and still has some anti-blooming capability, but can introduce some unwanted artifacts to the output HDR image.

- **Saving the HDR image**: Check this option and choose the directory and the file name at which the generated HDR image shall be saved in Radiance RGBE (*.hdr) file format. Saving the HDR image is possible only at this step.

Below is a comparison of the tone mapped HDRs with the anti blooming set to "None" and "Normal":

![Anti blooming: "None"](image1)

![Anti blooming: "Normal"](image2)

### 2.5.2. Smart Merge

This method doesn't generate a realistic HDR radiance map. Instead, it merges the photographs taking best exposed areas with higher weight. Since the under- and overexposed areas are rejected the achieved result contains the details visible in all photos from the differently exposed set. The method itself uses a local operator (see section 3), that's why it may introduce delicate haloing (refer to paragraphs 3.4 and 3.5).

The result is not a HDR image (from the scientific point of view), however in fact it may look much more realistic than results achieved with True HDR method.
After the image is generated with this method it is tone mapped with the available algorithms just as in case of True HDR or Image Stacking. In order to achieve most realistic results it is suggested to try first to tone map the photo with the “Mask” operator disabled. Tuning the “Gamma” should be done as the next step.

2.5.3. Image Stacking

Stacking is a method of blending photos by simply taking the average of the input images. The luminance value for each pixel is a sum of the true signal and of course the noise. If the photographed scene is static, the signal acquired for each pixel is constant for each photo taken at the same exposure settings, while the noise is random. The average of the noise aims for a constant bias and thus is easy to subtract by a slight contrast boost. In other words by taking an average of photos the signal to noise ratio (SNR) is increased. Also the dynamic range is expanded given the image quality improvement for the darkest areas.

The following example shows the comparison between a single, enhanced (LDR enhancement) photo and a stack of 5 photos that was processed with easyHDR. You can see the dramatic decrease of noise. The 5 photos were taken with Canon 350D at exactly the same exposure settings (25 seconds, ISO400, f-number: 3.5).
You can also try to stack differently exposed photos instead of generating a HDR image. The result will be characterized by improved dynamic range, but cannot be called a High Dynamic Range radiance map, because the input photos are not calibrated and the luminance scale is untrue. Nevertheless the result may be pleasing in some cases.

3. Tone mapping

When the HDR radiance map is generated, the next step is typically to tone map it, so it can be displayed on the computer screen, saved in a typical image format or printed. Thanks to tone mapping the dynamic range of the photographed scene is preserved and fitted into the capabilities of display media (or storage formats). The resulting photo is in fact LDR (Low Dynamic Range), but it contains details present in the whole dynamic range of the photographed scene. Therefore it is wrong to call the result a HDR or either LDR image. It should be called a **tone mapped HDR radiance map**. Tone mapping does not only apply to the processing of HDR images. A digital camera applies tone mapping (with a global operator - in this case a simple curve compression) in order to fit the acquired (i.e.) 12-bit image pixel data into 8-bit per pixel (per channel) picture format.

When the HDR image is generated the size reduction is enabled automatically (by default). It allows much faster processing each time the tone mapping settings are changed. When you finally find the best settings just set the size reduction back to "1x" or click the "Process all" button. When the reduction is disabled (set to "1x") it is possible to preview a preselected area of the photo at full resolution. In this way you can see how the result photo will look like in finest detail, while minimizing the preview generation time.

EasyHDR allows you to save and load tone mapping settings. You can also find the "settings revert" and "default settings" toolbar buttons very useful.
3.1. **Global vs. local operator**

There are 2 operator functions from which to choose. If the "Mask" checkbox is checked the local operator is turned on. In this case, the additional local compression function called the "Local Contrast" can be used as well. The global operator is always enabled.

The global operator works the same for all pixels in the processed image, regardless on their position. The result for each pixel is computed by using only the operator parameters set by the user and the pixel's value. This ensures that there will be no brightness inversions in the output photo, leaving it as natural as it is possible, while fitting the selected scene dynamic range into the display media capabilities. No brightness inversions mean that the areas that were brighter than others in the real, photographed scene, will remain brighter. This limitation makes it very difficult to compress the entire dynamic range, without washing out colors or loosing local contrast.

The local operator, on the other hand, is spatially variable. The local parameters are computed for each pixel independently while taking its neighboring pixels into account. Therefore the local operator is capable of greater contrast reduction on wide scale, at the same time preserving local contrasts (details) and colors. When the effect is too strong, however, the photo may become unnatural – areas that should be bright can turn very dark and the "halo effect" can show up.

The local operator works similarly to local, chemical adaptation in the human eye, which is one of the factors that make the human vision capable of sensing very wide dynamic range. Note that in classical digital photography only the global operators are used (i.e. gamma preprocessing inside a digital camera).

The parameters for the global operator in easyHDR are:

- Compression,
- Gamma,
- Saturation,
- Curve adjust tool,

for the "Mask" local operator:

- Strength,
- Smoothness,

and for the "Local Contrast":

- Strength,
- Range,
- Level.

3.2. **Global Operator: Compression, Gamma & Saturation**

**Gamma** curve transformation is a function available in most image editing software. It brightens or darkens the photo, but it does not cause any image data to be lost, by clipping the pixel values to black or white. It applies a non-linear (gamma curve) transformation that compresses the whole dynamic range of the processed photo. When the value is higher than 1.00 the pixel luminance in shadows is amplified more than in the bright areas, therefore the compression is achieved.
The “Compression” function applies a similar non-linear transformation as gamma adjust. However as opposed to the gamma function, it preserves and even increases the color saturation. See the example below.

a) Photo tone mapped with default settings (Gamma = 1.00, Compression = 1.00) – only global operator is applied, b) Gamma = 1.40, c) Compression = 1.80, d) Gamma = 0.70, Compression = 1.80.

Both parameters should be used together in order to get best results. In example, if the photo gets too bright after the “Compression” is increased, it can be darkened with the “gamma” setting.

The tone mapping operators – both the global and the local, alter the color saturation of the photograph. The “Saturation” function can be used to compensate for the color loss, or to decrease the saturation if the colors are unnaturally vivid. Note that this setting shall be modified as the last one.

3.3. Global Operator: Curve adjust

Curve adjust is a very powerful, but simple in use tool that is implemented in almost every image editing software. It offers much more flexibility than the gamma curve adjust. The user manually shapes, using special knee points, the non-linear curve that is used to compress the dynamic range of the photo. The points can be created by simply clicking in the curve area with the left mouse button. Knee point removal is done by pressing the right mouse button while the cursor hovers over the selected point.
The curve tool that is implemented in easyHDR operates on floating point HDR rather than 8-bit fixed-point, LDR (Low Dynamic Range) image data, as it is done in normal photo editing software. Because of that, operations can have different, much better effects, i.e. brightening shadows does not necessarily mean boosting noise level (of course there must be enough shadow information in the HDR composite).

The curve tool does not make any changes to the output image when it is in the reset position (straight line). It gives enough flexibility when there are 2 or 3 knee points.

If the curve is not rising in the entire luminance domain a warning is issued (see rightmost image above). Note that in such a case the luminance inversion occurs. It appears as very unnatural color and luminance variations that of course should be avoided.

3.4. Local Operator: Mask

The "Mask" operator works similarly to a gray filter mounted in front of CCD or CMOS device during the exposure. The light coming from the photographed scene is focused on the surface of the imaging sensor, but the filter attenuates it in certain regions more than in the other. The idea is similar to using a gradient, gray filter mounted in front of the camera lens.

In case of HDR image processing, the High Dynamic Range radiance map that is recovered from a sequence of photos is the estimated irradiation of the surface of the imaging sensor during the exposure. EasyHDR calculates the complex gray filter mask based on the input HDR image and applies the attenuation. The brighter, large-scale areas are attenuated stronger, than the shadows. Since the mask does not affect the small-scale luminance variations, the local contrasts (details) are preserved – they are not flattened.
A linear gradient gray filter may be enough in case of the simple scene as shown here. The two photos on the left are real single shots of the same scene taken with different exposure times. On the right side there is a simulated view as if the photo was taken with a gradient, gray filter.

The strength of the mask operator is controlled with the "Strength" parameter. Higher values mean stronger attenuation of the bright areas, while the darker areas are more strongly intensified.

In case of both photos: gamma = 0.70, compression = 1.50.
   a) Strength = 0.70, b) Strength = 1.20.

The "Smoothness" factor controls the extent of blurring used for generation of the mask. Smaller values mean that smaller areas are regarded as "large-scale" which affects the global scale dynamic range compression as well as local contrasts preservation and the "halo" effect.

a) Smoothness = 0.50, b) Smoothness = 2.00.
3.5. Local Operator: Local Contrast

When the "Mask" operator is enabled the "Local Contrast" function can be also turned on. The operator enhances contrast at local level in order to bring out the fine details, that are typically flattened when the dynamic range is compressed. The "Local Contrast" function is very sensitive, so it can increase the noise, by amplifying it along with the real details visible in the photo. It can also bring out the JPEG compression artifacts if the input photos were compressed too strongly. Another disadvantage is that it introduces the "halo" effect (when the "Strength" is too high). However, when used correctly it makes the photos look much more dramatic.

The "Local Contrast" function is controlled by three parameters. The "Strength" defines the overall amount of contrast boost. "Range" parameter controls the extent of the operator. Low value means that smaller details are more strongly boosted, while when the value is higher, the influence of the operator is stronger on wider areas of the photo and at the same time the smaller details are less affected. The "Level" parameter defines the selectiveness of the "Local Contrast" effect. Higher values mean that it is stronger in highlights and weaker in darker areas. When it is 0.00, it equally affects any portion of the photograph that's being tone mapped.

![a) No local contrast applied, b) Local contrast applied (strength = 0.30, range = 1.00, level = 0.00).](image)

![a) Strength = 0.50, range = 0.00, level = 0.00, b) Strength = 0.50, range = 2.00, level = 0.00.](image)
Note: When the Local contrast is applied when the "size reduction" is enabled, the preview will be much more noisy than the real result that will be achieved at size reduction = 1x.

3.6. Black & white clip

The human eye is not able to "see" the whole dynamic range of every scene, so if you want to achieve a natural effect it is sometimes good to clip some shadows to black and some bright areas to white. By losing some information in those areas you get a better looking, more natural image with better contrast. By default 0.1% of the darkest pixels are cut to black and the 0.3% of the brightest are clipped to white. This makes the result look much more natural and not washed out, while sacrificing only a tiny part of the dynamic range.

To set the clipping points just move the markers over the histogram or manually set the desired cut-off pixel percentage, for black and white separately. There is also a possibility to set the clipping points by sampling the image with eyedropper tools. In order to use the eyedroppers click on the appropriate icon and then select the desired point on the image. Using left mouse button selects the point from the currently viewed result image, while using the right mouse button chooses the point from the input HDR image.

After setting the values manually in the edit boxes, click the "check" button to apply the changes - the markers will move to the appropriate locations.

If the padlock icon is "locked" the clipping is done automatically to the preset percentage values, for the current preview, when other tone mapping parameters are changed. When it is in the "unlocked" position, the markers always stay in the same place, but you can still update them manually by clicking the “check” button.
Example of the histogram clipping. Full HDR dynamic range is preserved in the photo a), while in case of photo b) the 0.6% of darkest pixels are clipped to black and 0.5% of the brightest pixels are clipped to white. This means that there is a loss in dynamic range, but at the same time the image is much more dramatic and has higher contrast. All is achieved by sacrificing only an unnoticeable amount of detail.

**Important note:** When the size reduction is enabled (different than "1x"), the automatic clipping is automatically turned on, but can be turned off by “unlocking” the padlock button. When the size reduction is disabled (set to "1x"), the automatic clipping is always off, because the histogram is calculated only for the preview area selected by the user and therefore cannot be assumed as an approximation of the true histogram of the full photo.

You can mark the overexposed (red) and underexposed (blue) areas to see how much detail is not available (was not recorded on any photo from the HDR sequence) or is lost due to clipping.

Click on the histogram to toggle the mode – left mouse button switches between RGB and Luminance mode, while the right mouse button selects linear or logarithmic Y-axis.
4. Post processing

If you are finished with tone mapping you may do some post processing to the output image before you save it in TIFF, BMP or JPEG format. You can use 4 filters: Gaussian blur, sharpen, median and bilateral filter. EasyHDR also allows you to manipulate color tones as well as apply basic transformations: rotate, mirror (flip) and cropping.

You can apply the changes either to a chosen preview area ("Preview" button) or to the whole image by clicking "Apply". To refresh the image to its current state click "Refresh" - all the preview changes will disappear. You can also undo the last "Apply" command using Edit->Undo.

4.1. Gaussian blur (smoothing)

You can use Gaussian blur filter to introduce some neat smoothing effect to your output photo. The higher the "Sigma" value the more blurred is the result. Use the "Opacity" setting to mix the blurred result with the input. You'll introduce an Orton look to your photograph.

![Gaussian blur examples](image)

a) Input photo, b) Sigma = 3.2, opacity = 100%, c) Sigma = 3.2, opacity = 50%.

4.2. Unsharp mask (sharpening)

The sharpening tool is 'a must' in every image editing software. You can change two parameters: "Sigma" (extent) and "Amount" (strength of the effect).
4.3. Median filter (noise reduction)

If you want to remove salt & pepper noise like hot pixels and you don't have a dark frame, this filter will be just what you need. It scans the masked neighborhood of each pixel and exchanges the luminance of the pixel with the computed, median (most probable) value. You can set the matching threshold, so only pixels that are significantly different than their neighbors are affected. It causes the noise to be wiped out while the other areas of the photo are left unchanged.

4.4. Bilateral filter (noise reduction)

The bilateral filter is a great noise removal tool that blurs noise while preserving edges. The example below shows how the filter works. The low-scale areas similar in luminance are blurred, while the significant edges are not affected.
Below is an example of noise reduction that was done with the bilateral filter compared to an effort to do the same with the Gaussian blur tool.

![Example of noise reduction](image)

\[ a) \text{Input photo, } b) \text{Gaussian blur: } \sigma = 2.0, \text{opacity} = 100\%, \]
\[ c) \text{Bilateral filter: } \sigma = 2.0, \text{opacity} = 100\%, \text{threshold} = 1.0. \]

### 4.5. Neutral point (white balance)

If the photos that you've taken are not well white balanced they also won't be after tone mapping. With easyHDR you can conduct all of the processing steps necessary between downloading the photo from a digital camera to publication on the Internet or to printing. That's why easyHDR features a sophisticated tool for white balancing. The procedure is as follows:

- Choose the eyedropper (sampling tool) type. The tool can pick the color of a single pixel that is selected, but it also can take a weighted average of the selected pixel neighborhood. This is a very big advantage that minimizes errors introduced by noise and color variations.
- Pick a sample on the image that should be neutral (gray).
- Choose the opacity and set the shadows-highlights selectiveness factor.
- Calculate preview for a selected area in order to quickly see the result.
- If you accept the results click "Apply" - the whole image will be processed.

Note that it is possible to do many iterations of white balancing to finally fine tune the color tones of the photo.
4.6. Sample/target balance

This is a more sophisticated version of the "Neutral point" tool. You may change sampled color tones into target colors (set by the user). For greater flexibility you can apply changes to shadows, highlights or midtones separately. Additionally you can limit the strength of the color transformation by lowering the opacity.
You can set the target color by clicking the left mouse button on the appropriate field. By clicking with right mouse button the color will be automatically converted to gray scale. You can also drag and drop colors between the fields. Double click in order to start the drag.

4.7. Color tone

In some cases it is easier to use “Color temperature” function rather than the Sample/Target Balance tool. You can easily make the color tones of the photograph warmer (shifted towards orange) or colder (shifted towards blue).

There is also a selective color saturation function available. It is possible to adjust the color saturation either for shadows or highlights.

a) Saturation (highlights) = 0.00, b) Saturation (highlights) = 2.00, c) Saturation (shadows) = 0.00, d) Saturation (shadows) = 2.00.
4.8. Image transformations

When you are finished with the tone mapping and post processing you can apply image transformations. These include rotation (90° clockwise, 90° counterclockwise and 180°), mirror (horizontal flip and vertical flip) and cropping. It is also possible to apply transformation before tone mapping, but HDR generation cannot be done again in that case.

The cropping tool allows you to cut a rectangular area out of the entire photograph. The area can be selected with a mouse, but it is also possible to set the desired width and height (in pixels). The area will be marked with the marquee after the “Create selection” button is hit.

You can fix the width to height ratio by selecting the “Aspect ratio” option other than “Custom”. It also applies to free hand selection with a mouse. The selected area can be moved over the photo with a mouse, while the Shift key is held down.

5. Batch processing

If you wish to process many image sequences, especially if the images are very big, you'll appreciate the advantages of batch processing. The idea is to create a list of many tasks to be done by easyHDR and then let the program do the whole job without user intervention. Below you can see the batch processing window (click File->Batch processing when no project is opened).
5.1. Task list creation

Each task is a separate image sequence to be processed. In order to add a new task click "Add task" button and select all of the images from that particular sequence. If you forget to select some images from the sequence, no problem, you can still add new images to the chosen task by clicking "Add images". Of course you can also remove any already added image or a whole task (marked in the list). Also a project created in the normal mode can be added as a separate task. In order to add it click on the "Add project" button.

Another way to add tasks, that can be very useful and efficient, is the "Add directory" feature. First create a specific directory tree structure with your photo sequences (if you don't have your images sorted this way already). Create a main directory, i.e. "C:\Photos" with subdirectories (i.e. "C:\Photos\Sunset") containing the photo sequences - one sequence in each subdirectory. To do so use "My Computer", "Windows Explorer", "Total Commander" or any other file manager. A separate task will be created for each of the subdirectories. The results of the batch processing will be (by default) saved to the main directory.

There is also an alternative way of task list creation in case when all the photo sequences are stored in a single directory. The program sorts the files by names and takes the user-specified number of photos to create the tasks.

If you're interested in processing only single photos (LDR enhancement) just check an option to create a separate task for each image and choose a directory that contains the files to be processed.
5.2. HDR Generation & Tone Mapping settings

Tasks that are separate easyHDR projects have their own predefined HDR generation and tone mapping settings attached. In order to set custom tone mapping settings for other tasks simply mark the chosen task in the list, choose your settings (you can load them from a file) and click "Use with selected task" button. If the settings have been changed and not saved a dialog widow appears, asking whether to save new or load a settings file that shall be embedded to the selected task. Modification of HDR generation settings (like: method, or curve type) is even easier. Just mark the task in the list and change the appropriate parameter. The change is applied immediately.

To read more about projects and settings in easyHDR go to paragraph 7.
5.3. "Save as" options and processing

The next step is to choose the result file format and the directory where the result shall be saved. The result filename is constructed as follows: "[task_name].[file_format_extension]".

At this point it is possible to execute the created script (task list). By clicking on the "Run selected" button only one (selected) task is processed. By clicking on the "Run all" button all tasks are processed and the results are saved in the chosen directory.

5.4. Generating HDR image files only

When the "Save output HDR to file" option is checked and the "Apply tone mapping" isn't checked the batch processing will produce the Radiance RGBE (*.hdr) files only without producing tone mapped results. This feature is very useful if you want to process loads of image sequences, but still want to have the full control on each of them, by manually setting the tone mapping parameters in the normal (not batch) mode. EasyHDR will produce the HDR image files for all of the sequences (batch tasks) automatically, then you'll save a lot of time on loading the images into the program for processing. Loading a single HDR file is much faster than importing a sequence of 3, 5 or even 7 images. This option is available only when True HDR method is selected.
6. Camera RAW image import

EasyHDR has a built-in graphical interface to the RAW conversion program DCRAW. The DCRAW software supports all (or nearly all) RAW file formats like Canon's *.CR2 and *.CRW. If you want to create a HDR image from a sequence of RAW images or just tone map a single RAW image you have to first convert your RAW images into 48-bit TIFFs. Note that by doing this no data will be lost since RAW images are in most cases 12-bit per pixel and the de-Bayered output is 16-bit per channel, per pixel.

It is also possible to directly load the RAW photos, just as JPEGs or TIFFs. The program will convert the images automatically and load the conversion result.
What are the RAW images?

The RAW images are simply files with raw image sensor data, plus some other information tags (like image size, camera settings, camera computed values that can be used to white balance the photo, etc.). Digital camera sensors - both CMOS and CCD - only "see" luminance not spectral (color) information. To get a color image the photo sensors (pixels) in the CCD or CMOS array are covered (in most digital cameras) with a Bayer pattern filter. The raw photo is therefore a black & white image that looks as if it were covered with a grid (image below). Because the Bayer pattern kernel consists of four pixels (RGGB) the output (de-Bayered) color image should have half the resolution. In practice interpolation is used to achieve full resolution color photos.

RAW images: are they HDR or LDR?

When you take a photo in JPEG mode the sensor data is de-Bayered inside the camera. It is also white balanced, enhanced (i.e. sharpened) and the 12-bit per channel, per pixel values are compressed to 8-bit data. Later the JPEG lossy compression is applied and the photo is saved in the camera's memory. The compression from 12 to 8 bit data is done with a curve (similar in shape to logarithm) that is stored in a Look Up Table (LUT). The imaging sensor responsivity to light is linear so if the 12 to 8 bit compression was done with a linear function the resulting photo would look unnatural. This occurs because the human vision sensitivity is nonlinear. Therefore the curve shape is chosen to produce the best looking results. Of course some information is lost by quantization during that process. Although RAW images have the same dynamic range as JPEGs, the JPEG dynamic range is compressed. Therefore there is an advantage to shooting pictures using the RAW format. The RAW image stores more information than the JPEG, especially in bright areas, and does not undergo lossy compression like the JPEG.

Also note that the dynamic range of your digital camera is not determined by the bit depth of the ADC (analog to digital) converter - in most cases 12 bits. The real dynamic range is determined by SNR (signal to noise ratio) of the sensor and the ADC, although nowadays, good digital cameras have the SNR close or better (some even much better) than 70dB. The range for 70dB is about 3160:1 while a 12-bit ADC gives a dynamic range of 4096:1 in the perfect case.
7. Projects & Settings

In easyHDR it is possible to save only tone mapping settings as well as whole projects (with settings embedded to them). To save or load your tone mapping settings just click Settings->Save settings or Settings->Load settings.

It is also possible to go back to defaults or to reload (revert) the previously loaded settings after some changes have been made. The last 10 loaded settings files can be easily reloaded by simply clicking on an item in a drop-down menu in the toolbar.

When you save the whole project (File->Save project) the appropriate settings file is also created and is tied to the project file. When the project is saved to the same directory as the involved images, then only the file names of the images are saved. In that case the whole project (settings, project file and images) can be moved to a different directory. When the project is saved to a directory other then the one with images, then the full paths of the images are saved. In that case the project cannot be moved to a different location.

In the batch processing tool (section 5) you can tie previously saved settings files to chosen tasks in the queue. You can also add whole projects (with their own settings) as separate tasks to be executed. If you have many big image sequences to process, prepare your projects first. Finally add all the projects to the batch processing task list and click "Run all" - easyHDR will do the whole job automatically, saving the output photos to the desired directory in the chosen image format.

8. Saving the result

EasyHDR can save the results in TIFF, JPEG and BMP image formats. It is also possible to save the generated HDR radiance map as Radiance RGBE (*.hdr). However it is only allowed in the "HDR generation" window.

JPEG (Joint Photographic Experts Group)

The files saved in this format take little disk space. This is due to lossy compression that is used. Also, only 24-bit per pixel format is supported. Therefore you should only save photos as JPEGs
(especially at low quality setting) when you want to publish them on the Internet or have them printed. If you want to apply further post-processing in different program and you want to preserve high quality of the image, use the TIFF format instead.

TIFF (Tagged Image File Format)

The TIFF format is lossless. This means that you can read or write files unlimited amount of times without any quality losses. You can choose between uncompressed and lossless compressed TIFF. The compression is similar to ZIP file packing. Note that not all (especially older) graphic editing software are able to load a ZIP-in-TIFF compressed file.

You can also choose between 24 and 48-bit data. If you want to apply strong post processing in other software or even enhance the tone mapped photo again (as second iteration) in easyHDR, it is better to save the file as 48-bit TIFF (16-bit per channel). This ensures minimal and unnoticeable losses in quality.

EXIF headers transfer

EasyHDR is capable of transferring EXIF headers to the output photographs. It uses jhead.exe or exiftool.exe program to achieve this goal. Exiftool is capable of transferring full EXIF data from and to all image formats, while jhead transfers only limited EXIF information from JPEGs to JPEGs.

EasyHDR adds an additional (“comment”) tag to the EXIF data. It contains information about all of the photos that were used to generate the HDR.
9. Program options

Most of the program settings are saved automatically when the program is terminated (like: "auto preview", "mask", JPEG quality, save file type, etc.). There are however several options that have to be set manually. In order to modify the settings click "Settings->Program options". A window will appear:

**Scratch pad memory**: You can choose here which hard drive (or directory) should be used by easyHDR to store temporary data. The option is set to system temporary directory by default. It should be modified only if you have little free space on the hard drive where easyHDR directory is located. The necessary free space for the program to work properly depends on how big images you want to load into the program and how many of them are in sequences you blend into HDR. Here is an example: five 8MPix JPEGs will require about 120 MB. If you load five 48-bit TIFFs the required free space will be double (240 MB). Make sure to secure more free space that is needed.

**CPU multi core support**: EasyHDR is capable of using several CPU cores (2, 4 or even more), if they are available. Multi-threading is used however only in case of some functions – where it was justified and feasible (some functions cannot be efficiently split into multiple threads that run in parallel). It is possible to select the maximal number of cores used by the program in normal or in batch mode separately. Note that when the maximal number of cores to be used is the same as available number of cores, easyHDR will claim 100% of CPU time during some operations. That means that other processes running on your system will work much slower during that period of time.

**Open & save picture windows**: The default view style can be chosen here. It can be one of the following: thumbnails, list or details.

**Actions after HDR is generated**: Automatic size reduction can be enabled and configured here - you can set the maximum preview image size. Also you can enable here automatic preview calculation (done after HDR is generated or LDR enhancement button is clicked).

**Asking for confirmation**: Enable or disable confirmation/warning dialogs when: a new project is started, saving the result or the "Process All" button is clicked while the size reduction is enabled, stacking is used instead of HDR generation.
**Miscellaneous:** If you'd like to be able to open several tool boxes at one time - i.e. both, "Curve adjust" and "Tone mapping" you can enable it here. This setting is suggested if you're working at high screen resolution. You can also switch on/off the hints that show up when mouse is moved over the sliders and buttons in the "Tone Mapping" tab. It is also possible to disable automatic preview calculation when a new image area is selected during tone mapping. Another option is registration of easyHDR as the default application for loading *.hdr files.